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Introduction
This manual should serve as one of the primary tools for installation and operation of the Capture software.
Capture Sweden’s e-mail support and online web forum are available as important complements to this
manual. http://www.capturesweden.com
Please visit our website for regular software updates and important product information. Also make sure to
notify us if your e-mail address is changed, since e-mail is our primary communication channel.

Microsoft Windows
Capture is distributed with a Microsoft Installer (.msi) package available from our web site. Once you have
downloaded the installation package, simply double click it to launch the installation.

macOS Installation
Capture is distributed as an “.app” package inside a .DMG (Disk Image) available from our website. Once
downloaded, it can be run from any location. When run, the latest version of the library is automatically
installed if necessary (hence it’s possible to have multiple versions on a system, but they will all always use
the latest version of the library).

The License Key File
Capture licenses are oﬀered on a personal basis, which means that it is possible to use the key-ﬁle on more
than one computer. As a result of that, it is also necessary to unlock the key-ﬁle on each computer, so that
we can keep track of your Capture installations.

If you have purchased a Capture license and received a key ﬁle, you will need to install it. This is done from
inside Capture; Open the Licensing dialog from the Tools menu and click on the Install key ﬁle button. Once
you have chosen the license key and it has appeared in the window, choose either ‘Automated unlock’ or
‘Manual unlock’ if you are not connected to the Internet.
The manual unlocking process may take some time as it requires manual attention from the Capture
Sweden staﬀ, but we will help you as promptly as possible.

Library Updates
Library updates are continuously available on our website, http://www.capturesweden.com. If you have
requested library additions, this is where you will download an updated library package when we have
notiﬁed you of completion of your request. Each release of Capture also contains the latest available library
package.

Support
Support to our customers is oﬀered through e-mail and our online web forum at http://www.captureswede
n.com. Under extraordinary circumstances we may also communicate with you over telephone, Skype or
MSN. For fastest possible assistance, please make sure to e-mail us at the appropriate e-mail address. For
questions regarding functionality or operation: support@capturesweden.com. For questions regarding the
library or if you are missing ﬁxtures: library@capturesweden.com.
Here are some things we will always ask you to do before helping you out:
If you are a Microsoft Windows user, make sure that you have all the latest applicable service packs
and hotﬁxes from Windows Update.
If you are a Microsoft Windows user, check that you have the latest drivers for your computer
components and your graphics card in particular.
Check that you have installed the latest version of Capture and the latest library update.

Demo Version Limitations
The demo version of Capture comes with two (and no other) limitations:
The Save function is disabled.
The software will only run for 90 minutes.
There are no limitations in terms of console or media server connectivity or the number of universes
available for visualization.

Software Overview
On startup the Welcome dialog is shown with shortcuts to open recently opened project ﬁles and the
Capture news feed. Once this has been closed, the main Capture interface remains.

The main components of the interface highlighted in the image are:
1. Main menu.
2. Design views (three in total).
3. Project window.
4. Navigator selection interface.
5. Navigator view interface.

Main Menu
The main menu is available at the top of the main window.

In the File menu you will ﬁnd the basic commands for opening, saving and closing Capture project ﬁles.
Note the variety of diﬀerent options are available for opening older Capture project ﬁles.
The Import Model feature is used to open up other project ﬁles in parallel and allows you to copy items
from other projects into the project you are working with (which is done using the arrow navigator button).
The Import Data feature allows you to import a variety of drawing formats from other programs, as well as
speciﬁc project data such as ﬁxture patch, weight, etc.
The Import Project Content feature allows you to import layers, ﬁlters, reports, plot styles and plots from
another project.
The Export Presentation feature that allows you to create an executable ﬁle that will launch your project,
which is embedded in the executable ﬁle, and show the Alpha view. Presentations cannot be used to edit
project ﬁles, they merely serve as a viewing and presentation tool.
The Export for Capture Nexum, Atlas, Argo functions allow you to export your project to older versions of
Capture.
The Export focus sheets feature creates a set of images, one per ﬁxture (or as conﬁgured in the
conﬁguration dialog presented), giving you a view out through the aperture of the ﬁxture. It requires you to
pick a folder into which the images are placed.
In the Edit menu you will ﬁnd access to the unlimited Undo and Redo commands.
The Tools menu gives you access to the Options window and the Translation window.

Design Views
Capture has three design views, Alpha, Beta and Gamma. These views can be conﬁgured to the users
liking. Conﬁguring a design view is done by clicking on the green list button as shown below.

Command
Wireframe

Plot
Live
Custom

Camera

Description
Wireframe is the default view and works as a 3D CAD wireframe view whereby
a user can orbit any object in 3D but it is only rendered in wireframe.
Replaces the Paper view from previous Capture versions. This view is used to
make plots.
Live 3D rendering view.
In Custom mode, you can conﬁgure your own look view with either
wireframe/solid, perspective/orthographic etc.
Camera shows a list of preset camera positions for quick navigation, as well as
the ability to launch one of the user made camera positions.
By positioning the camera to a user deﬁned location, a user can then go to the

Store Camera

Store camera option and choose a camera preset to store the current camera
pose to.

Grid

Grid toggles the grid on/oﬀ for the selected view.

Widgets

Widgets (such as the camera) can be toggled on/oﬀ for the selected view.

Hidden Objects

Hidden objects can be toggled on/oﬀ for the selected view.

Project Information

Toggles the project information on/oﬀ for the selected view.
Fixture information replaces the previous Live Information option from

Fixture Information

Capture Argo. It overlays ﬁxtures with programming information like shutter
and color mix status.

Quality Information

Toggles the FPS and quality info on/oﬀ for the selected view.

Save Image..

Save an image of the currently selected view.

Some view settings are not available in the navigator. Additional settings for each view are available in the
Design tab of the Project window. With the Views category selected, each view has one column of
properties appear on the right hand side.

The Grid width and Grid height properties determine the distance between grid lines.
The Vertical ﬁeld of view property lets you control lens angle of the view’s camera.
The Aspect ratio of a view can be set to follow 4:3 as well as 16:9.
The Brightness, Exposure and Atmosphere settings controls the look of the view when in Live mode. If you
have enabled the “Simpler Graphics” option of Capture, Brightness and Exposure are replaced with Fixture
Lighting and Fixture Lighting Diﬀerentiation.

DMX Control
It is possible to control a view using DMX. This is achieved by either manually assigning a Patch universe /
channel or by dragging the view’s camera from a design view to a channel in a universe view. The Patch
mode option can be used to select the number of channels used by the camera.

1

Channel

Function

Channel

Function

1

X Coarse

10

Tilt Fine

2

X Fine

11

Pitch Coarse

3

Y Coarse

12

Pitch Fine

4

Y Fine

13

(unused)

5

Z Coarse

14

Ambient

6

Z Fine

15

Lighting

7

Pan Coarse

16

Atmosphere

8

Pan Fine

17

Layers Set1

9

Tilt Coarse

18

Scene1

A total of 64 slots each occupying 4 DMX steps, ie. 0-3, 4-7, 8-11 and so on.

Project Window

The Project Window is the main information area in Capture. It hosts the properties for the selected items,
additional settings for the Alpha, Beta and Gamma Views, settings for Layers and Filters, Scenes, Materials,
Custom Gobo wheels, Custom Frame (color) lists, Reports Plot styles and Plots. Furthermore, the window is
split into a navigation list down the side with the properties for whatever is selected from that list available
on the right. Along the top are some tabs - Design, Fixtures, Universes, Media, Snapshots and Library.
Generally speaking, to add an object of any type to a capture project, it needs to be dragged from the library
tab to one of the design views. Objects can only currently be dragged into a wireframe or plot view.

Navigator
The Navigator is one of the main tools of capture. It is used for two primary functions - Navigation and
Manipulation.

The navigation part of the Navigator is present in the bottom right corner of the Alpha, Beta and Gamma
views. This Navigator is used to manipulate the view in terms of changing the camera viewing point and
zoom within the view as well as accessing the view settings via the spanner button.
The First button, a curve with arrows, allows you to move around a view. Holding the Shift or Ctrl keys allows
a diﬀerent style of movement in the 3D views.
The second button is used to zoom in and out on the selected view. Holding the button and moving the
mouse up or down will control the amount the camera is zoomed in or out.
The third button is used to access the settings for the selected view as we discussed earlier. Additional
settings for each are available in the Design tab of the Project window.

Whenever you select any objects, within any of the Alpha, Beta or Gamma views within Capture; a second
type navigator appears. When objects are selected, they appear red with a a red grid around them that has
some control buttons below it. This second type of navigator is used to assist in the manipulation of the
objects.
Objects can be selected by clicking on them with the mouse. Use the Shift key to add objects to the selection
and the Ctrl key to toggle individual object selection on and oﬀ. By click-dragging the mouse over a group of
objects, you can select them all at a time. If you drag from the left to the right, the objects must lie
completely within the region, but if you drag from the right to the left, it is enough for the objects to be
partially inside the region in order to become selected.
Clicking and moving the mouse anywhere inside the Translation grip allows you to move objects around.
This area is intentionally large so that it is easy to move items. While moving items, you can enable the ortho
mode by pressing Shift key. Snapping in the sense of bringing items to a minimal distance is built in and
activated during any translation, but is not triggered until after a short delay. When snapping is activate, the
result of the snapping is illustrated with an alternate colour.
Clicking and moving the mouse inside a Distribution grip will allow you to spread out or bring together the
selected objects over the given area in a proportional manner. The ortho mode is available here by using
the Shift key as well. The Rotation anchor is used to rotate objects. It can be moved around to deﬁne the
center of rotation and allows for both Individual rotation and Group rotation. Pressing the Shift key enables
snapped rotation.
The ﬁrst button is the selection menu button. It allows you to select or deselect everything, with the added
“layer” option. Using the “layer” option will allow you to select or deselect everything but only in the current
layer. Layers will be discussed in a later chapter.
The second button is the actions menu button. It displays a small list of possible operations relevant to the
selected object(s). The list that appears is context sensitive, that is to say that selecting a Lighting Fixture will
display diﬀerent options in the list than that of a Truss. Each available option/command will be covered later
in the relevant chapters.
The arrow button is used to drag objects out of one view to another. Using this button, the objects won’t
actually move per say. The button is used primarily for patching ﬁxtures. Select multiple ﬁxtures in the order
you wish to patch them and use the drag button to drag them onto a universe in the project window or on
an open universe window. This functionality will be covered later in the relevant section.
You may also use the arrow button to drag the object to a new location in the same window, thereby making
a copy.
The button with a list is the Quick Summery button. Pressing it when you have objects selected presents a
popup window about the selected objects displaying key data about them. This button reveals the ﬁxture
control pane and is only visible when at least one lighting ﬁxture is selected and the view is in Live mode.

Smoke Settings
Since Capture Atlas, Smoke is no longer a global setting, but a placeable and modiﬁable element of your
design. Typical applications include denser smoke on stage in an arena with thin haze or other localized fog
situations such as heavy fog or fog behind a glass. Being able to limit smoke to the area around the stage
helps avoid problems with beams shot into the audience over saturating the visualization. The Smoke
element is in a new project by default (much like the camera object).

Smoke can also be patched to DMX control. It has 2 control channels, Density (1) and Variation (2). It can be
patched by manually dragging the object using the select button into your chosen universe window (much
like a ﬁxture) or manual given an address once it is selected by changing its patch property in the Design
tab.

Rendering Settings

The rendering settings (previously visualization settings, under software options) is a tab within the project
window. Its properties control the rendering quality of the live design views.
The Multiple Apertures visualization option controls the rendering of multi-aperture (striplights, BB-7,
multi-LED moving heads) beams. In simple mode, only a single beam is rendered using the ﬁxtures average
color.In realistic mode each aperture renders a beam of its own. In Automatic mode a single beam is
rendered for the ﬁxture when all apertures have the same color.
The Beam Atmospheric Detail option allows you to control the level of detail created by a beam passing
through the smoke/haze in the atmosphere.
The Beam shadow resolution option allows you to lower the resolution of shadows created by beams.
The Automatic Quality option allows you to turn on/oﬀ the automatic quality functionality Capture uses.
Having automatic quality turned on will allow capture to be more eﬃcient while rendering more complex
scenes by sacriﬁcing quality to keep good performance.
The Resolution Scaling option allows you to render live visualization at a lower resolution than the screen.
The Atmospheric Resolution option controls the resolution of atmospheric visualization, (Smoke). The
Beam
Atmospheric Details option allows you to control the level of detail created by a beam passing through the
smoke/haze in the atmosphere. Higher levels of Beam Atmospheric Detail are relevant when using many

wide angle beams and/or shooting through scenery that intersects beams.
The Beam Shadow Resolution option allows you to increase the resolution of shadows created by beams
when shooting over long distances or on/through scenery.
The Spill Lighting option enables the visualization of a beam contribution beyond a ﬁxtures ﬁeld angle.
The Frosted Transparents option allows you to disable the visualization of the frosted eﬀect of transparent
materials.

Software Options
The software options are available through the Tools menu Options command and are split in two
categories.

General Options Tab
Here you can change the language of the user interface in Capture. By default it will follow the settings of
your computer.

The Ignore C: drive options is important on Microsoft Windows machines that have their Windows
installation on a drive other then C : \
Turning on the Live updating transformation option causes all simulation views to update at once when
moving or rotating objects.
Locking layers is a useful way of preventing accidental modiﬁcation of ﬁxed items such as the house of
your venue. The Locked layers unselectable option takes it one step further and prevents you from even
selecting such items.
The Show navigator on external selection is a feature for users with controllers that are capable of
selecting ﬁxtures. Unless this option is enabled, ﬁxtures selected from a controller will only highlight as red
and not display the navigator with the command buttons.
Free-ﬂight navigation is normally accessible using the Shift key when navigating but can be set as the
default behaviour instead (in which case the Shift key can be used to access orbit navigation).
The size of the navigator’s rotation anchor can be changed with the Rotation anchor angle and Rotation
anchor length options. The rotation anchor snapping angle can be set with the Rotation snap angle
option.

Connectivity Options Tab
This tab contains options for controller and media server connectivity. It can be important to set the
Preferred network address on a machine with multiple network addresses, but unless you are connecting to
older equipment it is not encouraged to enable the Compatible CITP mode as it may make it impossible to
connect to newer equipment.
You may also alter the incoming video format for CITP communication.
By default, Art-Net, sACN (E1.31), Compulite VC, ETC Net 2, HippoMap (HMap3), Lan Box, Lasergraph DSP
and PangolinLD are all set to Automatic. On rare occasions when a machine has more than one network
adapter, it may be necessary to change Automatic to a speciﬁc IP address available under the relevant
protocol.

Object Manipulation
Any physical thing in a Capture project ﬁle is an object, whether it be a Lighting Fixture, piece of stage deck,
LED screen, table or chair - is irrelevant. They are all treated the same in respect to adding them to the
project, moving them around, cloning (copying) them, deleting them and accessing their properties.
To explore more about object manipulation, start a new Capture Project. Do this by going to the main menu
in the top left corner and pressing New.

Leave the Alpha and Beta views with their default settings. Change the Gamma view to the Live mode by
clicking on the green list button and selecting Live. Your windows should look the same as the image below.

Adding Objects
Now we have a clean project ﬁle, we can proceed to add some objects to it.
To add an object to the project, we must ﬁrst locate it from the Library. The Library tab in the Project
Window is where all objects can be located. We want to add a stage ﬂoor.

Navigate to the Library, click on Objects, then again on Forms. Click on the Box form and drag it into either
the Alpha or Beta view. Your project should look something like the image below.

We can now proceed to changing the properties of the box so that it looks more like a stage ﬂoor. You may
select the box by simply clicking on it in any of the views. The red navigator will appear around the box.
Press the red spanner button to present the options available for the box.
Click the Properties option. This will toggle the project window to the Design tab with the Selected Items
section already active showing the properties for the box.
Change the box dimensions to a width of 12m, height of 0.1m and a depth of 8m. Your Properties should
look like the image below.

The end result will be the box looking a lot more like a ﬂoor.
Now we have a stage ﬂoor in place we can proceed to add some more objects. We will add some truss in
above the stage. Adding a piece of truss is done in the same way the box was added. Locate the desired
piece in the library and drag it into either the Alpha are Beta view. For the sake of example, we will use a
piece of truss from the Generic folder. Double click the Truss folder, double click again on the Generic
folder, and again on Box. Choose the Generic Rectangular Section and drag it into one of the views.

The Truss is 2m wide. We know that the stage ﬂoor is 12m wide. We now want to add more 2m sections of
truss to result in one long truss going from one side of the stage to the other. This can easily be done with
the Clone feature.
Click on the truss piece to select it. Press the red spanner button to access the available options for the
truss.
Click the Clone option, this will bring up the Clone window. Set the X Oﬀset to 2m and set the number of
clones to 5. This will then add sections of 2m truss right across our 12m wide stage evenly.
Currently, they still act as 6 separate pieces of truss. Select the pieces and press the red spanner button
again. Choose the Group option and now the 6 sections are grouped together. They can now be moved and
manipulated all as one.

Navigator commands
The navigator's actions menu contains a number of commands that can be used to manipulate the
currently selected objects.

Transform

This command allows you to move or rotate by an exact distance or amount of degrees. Use the green
navigator cube to guide you with the X, Y and Z directions in the current view. Note that the rotation angle
takes the placement of the rotation anchor into account and always performs a Group rotation.

Align
The Align option allows you to select a group of objects and quickly align them a long a speciﬁc axis very
quickly. Whatever align function is used is always relevant to the design view you are using it in. The options
available are displayed to the right.

Spread Even
The Spread Even function allows you to select a group of objects or ﬁxtures and spread them evenly along a
vertical or horizontal axis very quickly. It is extremely useful for making lines of objects very quickly.

Clone
This command allows you to create one or more copies of the object or group of objects you have selected.
Use the green navigator cube to guide you with the X, Y and Z directions in the current view. The oﬀset
values are applied incrementally which means that if you specify two copies with an oﬀset of 2m, the ﬁrst
copy will be created 2m away from the original and the second copy will be created 4m away from the
original etc. Note that the rotation angle takes the placement of the rotation anchor into account.

For instance you can create a circle of ten boxes by selecting a box, moving the rotation anchor of the circle,
choosing the Clone command, entering an angle of 36 degrees (a full circle of 360 degrees split in ten
objects) and 9 copies (since one box already exists, the result will be 10 boxes).

Sequential Unit

This command allows you to set the Unit property of the selected objects in a consecutive manner. You may
specify a Preﬁx as well as a Postﬁx to the numbering. The Start property deﬁnes the ﬁrst number of the
range. The Overlap property allows you to create series such as 1, 1, 2, 2, 3, 3 and the Gap property allows
you to create series such as 1, 3, 5, 7. Notice that if you select objects manually one by one, this deﬁnes the
order for the numbering. However, if you select them by dragging the mouse over the objects, the order of
the objects undeﬁned.

Sequential Circuit
Sequential circuit essentially works just like sequential uniting – except that you assign circuit numbers to
the Channel property of ﬁxtures. You may specify a Preﬁx as well as a Postﬁx to the numbering.

Sequential Patch
This command allows you to sequentially patch ﬁxtures. The order in which you select the ﬁxtures will be
the order they are applied to the patch. You may choose the universe and start address by entering the
address as Universe.Address. For example, entering 2.1 would have the ﬁxtures start at channel 1 on
universe 2. You also have the option of leaving a gap between ﬁxtures if you wish.

Sequential Channel
Sequential channel essentially works just like sequential uniting – except that you assign ﬁxture numbers to
the Channel property of ﬁxtures. Since it is a number and not text, you are not allowed to specify a preﬁx or
postﬁx.

Fixtures
Fixtures Overview
Fixtures are handled in pretty much the same was as other objects. To add a ﬁxture, it needs to be dragged
from the library to one of the wireframe design views. Fixtures can be cloned, moved, rotated and deleted
the same as any other object.
In this example, we add a single Mac 700 proﬁle from the library. We then clone it so that we end up with
one Mac 700 per meter of the truss.

Clone the Mac 700 Proﬁle 11 times so the 12m truss has 1 Mac 700 every meter. The Mac 700’s will then
span the truss equally.
Now that we have added the Mac 700’s. They need to be patched. There are two ways of patching ﬁxtures in
Capture. You can select the ﬁxtures you wish to patch, in the order you want them patched, and from the
red spanner (options) menu, you can select “Sequential Patch”. The sequential patch window will appear
giving you the options of “Start Address”, which is formatted by double clicking the option and entering
Universe.Address. For examples entering 2.1 would patch the ﬁxtures to Universe 2, Address 1. You may
also enter a “Channels between ﬁxtures” number, this is essentially an oﬀset tool.

The second option is to drag the ﬁxtures to a start address within a universe window. First, open one of the
project universes by clicking on the "Edit.." button in the “Universes” tab of the Project Window. Then select
the ﬁxtures in the order you wish to patch them, click and hold the drag button and drag them to a start
address in the open universe window.

DMX Universes
Once ﬁxtures are patched onto Captures internal universes, you can link those internal universes to
external universes that are coming into Capture via protocols like Art-Net or sACN. Very little user
intervention is required with most of these protocols - Capture will accept most of them in a “Plug & Play”
kind of manner.

Universes are managed in the Universes tab of the Project window. The left hand side shows the universes of
your project and the right hand oﬀers a preview of the selected universe.
Capture automatically links external universes to internal universes, but also oﬀers you the option of
overriding the setup. To do this, double click on the External universe column property of a universe and
choose the external universe you would rather use.
The Patch base property lets you choose the numerical location of a universe in relation to the other
universes, independent of its name.
In a theatrical environment it may be more convenient to work with a contiguous range of channel numbers
(for instance 1 – 2048). This can be achieved by setting the Patch style property to Contiguous.

Fixture Settings
All ﬁxture settings are available in the Design tab of the Project Window, as illustrated on the right hand
side. The settings are divided in several categories. It is possible to select multiple ﬁxtures at once to change
a setting for all selected ﬁxtures simultaneously.

Swapping Fixtures
Swapping ﬁxtures in Capture is very easy. To replace ﬁxtures, select the “old” ﬁxtures ﬁrst, then locate your
“new” ﬁxture from the library. Simply drag the new ﬁxture onto one of the selected “old” ﬁxtures. The
selection will go a purple color, once you see the purple color, release the mouse button and the ﬁxtures
will have been swapped.

Custom Gobos

Custom gobos can be created by right clicking on the Gobos branch in the Design tab. Once you have given
the gobo a name you can choose an image for it. Use a square image, up to 256 by 256 pixels in size.
Finally drag and drop the gobo onto any ﬁxture with a gobo slot to add it to the ﬁxture. If you have selected
multiple ﬁxtures as you do this, the gobo will be added to all of them.
Gobos (and ﬁlters) can be removed from ﬁxtures using the actions menu button.

Custom Gobo and Color Wheels
Changing Gobo/Color frames in intelligent ﬁxtures is very easy, simply open the current wheel via the ﬁxture
properties, double clicking on one of the current color/gobo slots in the properties opens the wheel, then
drag a new color or gobo from the library to a slot on the wheel and the ﬁxture is automatically updated.

The Fixtures Tab
The Fixtures Tab is part of the Project Window and shows all ﬁxtures in the show and subset of their
settings. The Fixtures Tab can be navigated and edited as a spreadsheet using the arrow and Enter/Return
keys. Multiple row selection is also possible using the Shift and Ctrl/Cmd keys and useful when dragging and
dropping ﬁxtures from the Fixtures Tab.

The Fixtures tab can be arranged in a number of ways. By default, the tab shows all ﬁxtures currently in the
project. It can be ﬁltered by using the search function in the top right corner. It can also be ﬁltered by
clicking a column header to organize the data in ascending (or descending) order for that property. For
example, in the image below, the window is ﬁltered to show the source four ﬁxtures ascending in patch
data. The arrow in the Patch property column header denotes that the sheet is arranged showing patch
data in ascending order. Clicking the Patch column header for a second time would toggle it into descending
order.

Materials
Using Materials
Materials oﬀer a way of applying a static image or video to an object. The best way to use a material is to
think of it as an example of what your object is going to look like. They are useful to make objects appear as
diﬀerent things, for example mapping a picture of a bricks to a thin box, making it appear as a wall.
The library contains a selection of materials which can be applied to objects by dragging and dropping them
from the library on to the object. To apply the same material to many objects, you can select the objects ﬁrst
and then drag and drop the material. The image and colour of the material is combined with the colour of
the object that the material is applied to. Hence, if the object’s colour is set to black, the
material will appear black.

You can create your own materials in the Design tab of the Project window, under the Materials category. You
can then apply either an image from a ﬁle, a video on the local hard drive or streaming video source from a
connected media server. To apply your own materials to objects, drag and drop them from the Materials
branch rather than the Library tab.
In this example, we will look at using Materials to change the appearance of a thin box. First, make a new
material in the project window.
In the material properties, available on the right when the material is selected, you may choose an image or
video source. Double click on the image option and choose an image from the local hard drive. In this
instance, the image will be a picture of some bricks. Once you have chosen the image, drag the material
from the project window to the object you wish to map it to.

Mapping Materials

Once you have applied a material to an object, you may wish to map the material. Mapping a material
consists of using the navigator to resize it, rotate it or ﬁll the object space with the material, the latter is
referred to as “Map to Extents”.

Moving and resizing the material with the navigator is done in the same manner as other objects. You may
Map a material to multiple objects at the same time. Simply select all to the objects and drag the material to
them, select the “Map Material” mode and map the material to your liking.

Material Properties
The Color property deﬁnes the base color of the material. Capture utilizes the Physical Based Rendering
(PBR) material model in which absolute white or black should normally be avoided.
The Texture image, Texture generator and Texture media choices are mutually exclusive and allow you to
apply a texture to the material. This texture is combined with the base color and unless you wish to tint the
texture with a color, the Color property is then best set to pure white.
Use the Texture Width and Texture Height properties to deﬁne the physical real-world dimensions of the
image, generator or media texture applied. These dimensions deﬁne the size of the image regardless of the
object it is applied to.
The Smoothness property deﬁnes how rough or smooth a surface is on a microscopic level. A material such
as concrete would have a much lower smoothness value than for instance varnished wood.
The Metallic property allows you to mimic metallic looking ﬁnishes for metal items such as a car or steel
beam. This should normally only be set to either 0% or 100%.
The Luminance property allows you to create materials that simulate light emitting surfaces such as ﬂat
screens or LED panels.

Transparency allows you to set transparency for an object so to act like glass or gauze. This property works
together with the Tint which determines whether items behind the object assume the colour of the object
itself, as is the case with glass but not gauze. Finally Frost allows you to to give transparent objects a frosted
eﬀect.

Texture Generators
Texture generators are a kind of crossover between media servers and static image textures. Texture
generators produce a matrix image where the cell colours are controlled by DMX. This can be used for a
number of eﬀects, for example dimming a luminous object or simulating an RGB LED tape.
Texture generators support two DMX modes - Dimmer and RGB. In Dimmer mode each cell is coloured
from black to white, based on a single DMX value. In RGB mode each cell’s colour is controlled by three DMX
channels.
When patching a texture generator the number of channels required is determined by the DMX mode
chosen and the number of rows and columns conﬁgured. Ie. a 3 by 3 matrix in RGB mode requires 3 x 3 x 3
= 27 DMX channels.

Media Fixtures
Video Projectors and Digital Lights
Capture supports a large library of Media Fixtures such as Video Projectors and Digital Lights. Adding a
Media Fixture to a Capture Project is the same as anything else - drag it from the library into one of
wireframe views.
With Projectors and Digital Lights, they need a video source for any output to be visible. Much like LED
Screens, the video source may be an internal video player were by you choose a video ﬁle on the computer
and play that. Alternatively you may also choose a video source from an external Media Server via CITP for
the video source of a Projector.
In this instance we will just use a ﬁle on the computer and look at CITP sources in a later chapter.
Add a video projector to the project by dragging it from the library to one of the wireframe design views. You
can select a non speciﬁc projector from the “Generic” section of Media Fixtures in the library. Add a box, and
change its properties so that it looks like a video screen. Position the projector so it is pointing at the screen.
A quick way to focus a projector (or any type of ﬁxture) is to right click on the surface you wish to focus it on.
In this case, its the screen on stage.
The projector will display a test image when it is turned on but not being assigned an image or media
player.

Now, to play video from the projector, you can create a video player within capture. Simply, go to the Media
tab in the Project window and press the Add button in the top right corner and name the video player
“Projector Video”. Press the Add Video button and choose a video ﬁle from the local hard drive. You may
select multiple videos as well as image ﬁles if you wish. Once you have selected the video you wish to play
through the projector, press the play button next to it so the video is playing.

Finally select the video projector and access its properties in the Design tab. Double click on the Media
property and choose the video player you had just created.

Video Players
As discussed in the previous section, you can use an internal Video Player to play videos or images on Video
Projectors in Capture. The Video Player can be controlled by DMX if desired. The Patch property of the Video
Player can be access by clicking “Settings..” for the desired Video Player in the Media tab.
Channel 1

Channel 2

0-7

Pause

0-31

Playlist entry 1

8-15

Play

32-63

Playlist entry 2

16-23

Replay (Play again from the start)
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(playlist entries 3 through 7)

24-31

Stop

248-255

Playlist entry 8

Using CITP Media Sources
Capture supports connecting to Media Servers using the CITP communication protocol. This makes it
possible to receive streaming video from a Media Server and apply it to objects like a material. You can view
all connected Media Servers in the Video tab in the Project window.

To apply a streaming video to an object, you must ﬁrst create a material, select the desired video source, set
up the dimensions of the material and then apply the material to the objects. Alternatively you may omit
setting up the material dimensions and simply map the material using the material mapping functionality
discussed earlier.
Little to zero conﬁguration should be required with CITP. Ensure that the Capture machine and the Media
Server are operating in the same range of IP addresses and subnet. If the Capture machine has multiple
network adapters, it may be necessary to manually select the adapter you will be using for CITP
information. This can be done in the Connectivity Tab of the Options menu.

Controller and Media Server Connectivity

Art-Net

macOS

Windows

Yes

Yes

Avolites ACDI

Yes

CITP

Yes

Yes
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Yes

ETC Net 2
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Yes

Green Hippo HMap 3
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High End Hog 3 & 4
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Kinesys K2
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LaserAnimation & Pangolin

Yes

Yes

MA Net 21
Streaming ACN
1

Yes
Yes

Yes

Requires MA software version 2.9. Requires manual activation; right click in the External

universes list of the Universes tab to open the MA-Net conﬁguration dialog.

NDI Video Sources
Capture supports receiving video from NewTek NDI (http://www.newtek.com/ndi.html) video sources. This
makes it possible to receive streaming video from a multitude of both software and hardware solutions.
There are also some useful tools for desktop streaming and tests available from the NDI web page of
NewTek. Capture lists all NDI sources it ﬁnds in the Video tab in the Project Window.
To apply streaming video to an object, follow the same procedure as with CITP Media Sources, described in
the previous section.
No conﬁguration is required for NDI, but it is possible to specify one or several NDI groups to limit NDI
reception to in the Connectivity Tab of the Options menu. If the Capture machine has multiple network
adapters, it may also be necessary to manually select the adapter you wish to use.

LED Screens
Using LED Screens
Capture is not only capable of 3D rendering for Lighting Fixtures, but also a wide range of LED Screens too.
Adding an LED screen to a project, is the same as adding a ﬁxture or object. LED Screens can be found
under the Fixtures category of the library. Locate the particular model you require from the library and drag
it into one of the wireframe design views. Use the clone function to clone the LED panel however many
times is required to create the screen size you desire. Once You have added in an LED screen of the desired
size. Mapping video to the screen is done with the use of Materials and Video Players.
Materials are images or videos you add to an object in capture. Video Players can either be an internal video
player were by you choose a video ﬁle on the computer and play that. Or you may also choose a video
source from an external Media Server via CITP for the video source of a material. In this instance we will just
use a ﬁle on the computer and look at CITP sources in a later chapter.
Add an LED Panel to the project by dragging it from the library to one of the wireframe design views. Clone
the panel so you have a suitable size of LED Screen. Your project should look similar to this.

Now, to play video on the LED Screen, you must make a video player within capture. Simply, go to the Media
tab in the Project window and press the Add button in the top right corner and name the Video Player “LED Screen Video”. Press the Add Video button and choose a video ﬁle from the local hard drive. You may
select multiple videos if you wish. Once you have selected the video you wish to play on the screen, press
the play button next to it so the video is playing. In the Design tab, select the Materials category and click
the Add button.
Once you have created the material, you need to link the material to the video player. Do this by selecting
the video player from the “Media” option within the material properties.

Once the Material has been assigned to the video player, drag the material from the project window to the
LED Screen in one of the design views. Press the red spanner button and choose the “Map Material” option.
Then select the “Map to extents” option, this will set the material to ﬁll the whole screen.

The result will be the LED Screen receiving evenly mapped video across the array from the Video Player.

Layers and Filters
Using Layers
Both layers and ﬁlters are managed in the Design tab of the Project window. Layers are useful to select &
group many objects of a similar nature. Filters are essentially just groups of layers and universes. For
example having a layer for “All Moving Lights”, “All Generics” and “All LED” could be useful. Then they could
belong to the ﬁlter - “All Fixtures”. Layers and ﬁlters are very useful for managing project ﬁles with large
amounts of objects & ﬁxtures in.
Objects in a layer with the Locked property set cannot be modiﬁed. When the Include in reports property is
unchecked, objects in that layer will not appear on reports. Live information and Fixture simulation can also
be turned on and oﬀ on a per-layer basis in the same fashion. Filters are used to deﬁne sets of layers to be
visible in design views and plots. They serve as layer ﬁlters and it is useful to note that you may work with
diﬀerent ﬁlters in diﬀerent views if you wish.
When a design view is patched to a universe it is possible to choose the design view’s ﬁlter via DMX.
However, this requires setting up the DMX control slot property of each layer that you wish to be able to
choose. There are 64 slots available and they are identiﬁed with the numbers 1 through 64. A value of 0
means that it is not possible to select via DMX.
Please note, that hiding layers does not aﬀect light and shows because the objects are still considered
physically present. So in order to achieve something like this, you must use Scenes.
Adding ﬁxtures or objects to a layer can be done in one of two ways, you may either drag the layer from
the project window to the selected objects or you may select the objects and double click the “Layer”
property in the properties and select the layer there. Adding ﬁxtures to an existing layer is done in the same
manner.

Using Filters
As already discussed, ﬁlters are essentially just groups of layers and universes. As per our previous example,
having a layer for “All Moving Lights”, “All Generics” and “All LED” could be useful. They could then belong to
the ﬁlter - “All Fixtures”.
Adding ﬁlters is done in the same way as layers. Click on the Add button in the Filters category of the Design
tab and name the ﬁlter. Once the ﬁlter has been created, in the right hand section of the window, a list will
appear showing all the layers and universes. You can use the check boxes to control which layers and
universes belong to the ﬁlter you created.

Scenes
Using Scenes
Working with scenes allows you to modify the position and visibility of objects in diﬀerent parts of a
performance. If you wish to do this, it is important to set the Include in scenes property of the objects that
wish to have dynamic positioning/visibility (this is important because many items such as the rig, truss and
house will usually not be part of what can be moved during a show and keeping them out of scenes
prevents you from making serious mistakes). Scenes are not stored or recalled – you are always working in
one scene at a time and you can safely switch back and forth between scenes without risking loss of any
position information. Scenes are most useful in a Theatre environment were you have one set of scenery for
Act one and another set of scenery for Act two. By default there is already one scene in any project ﬁle - the
“Default Scene”. To make more Scenes, right click on the scene node in the project window. Select “Add
Scene” and name the scene accordingly.

Once you have made a second scene, we can proceed to make a scenery change. Add some scenery and
position it as per your liking. Select all of the scenery, in the properties, locate the “Include in scenes”
property and set it to “Yes”. Now double click your second scene (or right click on it and select “Go to scene”).
Now we are in the second scene, move the scenery to a new location. Now switching between the two
scenes moves the scenery between the two locations.

Plots and Paperwork
Plots
The plots functionality in Capture allows users to create paperwork of lighting plots featuring key
information about the lighting rig. A plot can be viewed and edited in any design view that is orientated to
the top view & plot mode, as shown below.

Plot Options
Other than Fixture symbols, there are many other symbols that can appear on plots. The interactive image
below shows examples of the available plot symbols. Symbols such as Sightlines, Fans, Fog Machines,
Rigging Points etc may all be dragged into the project from the library just like other items. If you are
unhappy with the default symbol for a ﬁxture, you may drag a diﬀerent symbol from the library to the
selected ﬁxture.

Item

Description

1

Optical information

2

Annotation

3

Focus information

4

Patch & circuit information

5

Colour ﬁlter information

6

Rigging point

Fixture Properties with Plots
When ﬁxtures are selected, there are some plot speciﬁc properties that are useful to know about.
Symbol will control which symbol is used on the plot for the selected ﬁxture.
Symbol Usage will control which views the symbol actually appears in.
Direction snap is set to 30 degrees by default, this property controls the direction the ﬁxture is facing on
the plot.
Color by ﬁler will set the ﬁxture color to match the gel ﬁlter it has.
Focus is the property that allows text to be placed in front of the ﬁxture to indicate where that ﬁxture is
focused. Ie, drums.

Show Optics is the property that controls whether or not the plot displays the optical information of the
ﬁxture.
Show Wattage is the property that controls whether or not the plot displays the wattage information of the
ﬁxture.

Plot Styles
With Capture Argo, there is now an option to create styles for use with speciﬁc plots later. There are multiple
properties that can be included in a style, which can toggle on and oﬀ.

Exporting Plots
Once a plot has been made in a paper design view, it can then be exported for print. To do this, create a new
Plot by right clicking on “Plots” in the Project Window and clicking “New”. Multiple Plots can be added in this
manner. Adding multiple plots to the same project ﬁle is very useful for creating tidy plots for only certain
parts of a rig. Each Plot can be setup to show only certain layers based on the ﬁlter you select for the view.

Once you have added a plot in the Project Window. Double click on it to open it. The paper settings can be
changed in “Page Setup”.
Right clicking on the plot will allow you to add a view to the plot as shown in the image below. You may also
add Headers, Images, Text, Layer Keys and Symbol Keys in the same manner as adding a view.
Scale and move the plot to suit the paper.

Model Import
Using the Import Model Tool
The Import Model feature is used to import models from other ﬁle formats as well as importing content
from other project ﬁles. It opens these ﬁles in parallell and allows you to copy items into the project you are
working with by using the arrow navigator button.
When opening older project ﬁles, a window may appear telling you that some ﬁxtures have been updated
since the project you are trying to import from. Its good practice to hit “Update” so the new project gets the
same version of ﬁxtures as in the current library.
When you drag object into your project you have the option of placing them where you put the mouse
pointer or at their original position. Once you have ﬁnished, simply close the ﬁle you were importing from.
When importing models from other ﬁle formats attempts to preserve Drawing block name and Drawing
name information. This information can later be useful when replacing imported objects with library
ﬁxtures, either manually or using the Import Data feature.

Supported Model File Formats
Capture is able to import drawing information from other softwares using the ﬁle formats described below.

Autodesk DXF and DWG (.dxf and .dwg)
The DXF format is a relatively simple text based format useful to transfer smaller models and drawings of
simple nature. The more complex DWG format can contain more complex information such as solids and
materials.
Both the DXF and DWG formats stand out in the fact that they do not enforce a model object hierarchy – a
drawing could consist of loosely scattered polygons and lines only. As this is a problem for Capture, all
drawing content that does not belong to a “block” will be grouped by layer, material and solids to single
objects in Capture. In order for textures to import, the texture image ﬁle must located at either the same
path as on the computer on which the DXF or DWG was saved, or in the same folder as the DXF or DWG ﬁle
being imported.
Block deﬁninition names are used as the Drawing block name, however the name of block deﬁnitions that
only reference other blocks is also used as the Drawing name.

Cinema 4D (.c4d)
This is the native format of Maxon’s Cinema 4D 3D package.
In order for Capture to be able to import model data from a C4D ﬁles it must either have been saved with
the Cinema 4D preferences setting Files / Save Polygons for Melange set or using the Save Project for
Melange.. function.
All objects in the scene graph are imported, but the tree as such is not preserved in any way. Only ﬂat and
UVW texture projections are supported.

Object names are used as the Drawing name and the name of the object referenced by an instance object
is used as the Drawing block name.

Cinema 4D Hantmade Stage Plugin Support
When importing Cinema 4D ﬁles, Capture recognized Hantmade Stage ﬁxtures and imports them as single
objects. If a Capture ﬁxture identity has been set a ﬁxture’s Capture export settings, the ﬁxture is
automatically replaced with a ﬁxture from Capture’s library.

Sketchup (.skp)
This is the native format of Trimble’s Sketchup make and Sketchup Pro software packages.
While Sketchup supports double-sided materials Capture does not and will favor the front material over the
back material. Capture will also preserve block and group transformations (useful for replace ﬁxture
operations) as long as no lines or surfaces in the group have been subject to mirroring.
Group and component names are used as the Drawing name and component deﬁnition names are used as
the Drawing block name.

WaveFront (.obj)
This ﬁle format was developed by Wavefront Technologies for its Advanced Visualizer animation package in
the 1980s. It is a simple and text based, yet very competent ﬁle format.
As with the 3DS format, OBJ ﬁles do not have material textures embedded. Instead they are loosely
packaged alongside the OBJ ﬁle, typically in a separate folder.
Group names are used as the Drawing name.

3D Studio (.3ds)
This ﬁle format was the native format for the early versions of 3D Studio, a very popular 3D modeling
software. It is rich in material settings and information required to produce very realistic models. Capture
successfully handles most of the information in a 3DS ﬁle, however some of the more advanced material
properties are not supported. 3DS textures are not embedded inside the 3DS ﬁle but loosely packaged,
typically in a folder alongside the 3DS ﬁle itself. Be careful to take this into account when sending and
receiving 3DS ﬁles! There is a rich amount of 3DS ﬁles available on the internet. However, many of these
have been converted from other formats using automatic conversion tools of questionable quality.

Fixture Data Import and Export
Using the Import Fixture Data Tool
The Import Fixture Data tool can be found in the File menu and allows you to import a CSV text ﬁle
containing ﬁxture information which can be used either to add new ﬁxtures to or update existing ﬁxtures in
your project.
CSV ﬁles are text ﬁles with information structured in a spreadsheet-like manner using (typically) commas as
column dividers and linebreaks as row dividers. Because they are text ﬁles they can be opened and
modiﬁed in text editors such as TextEdit or Notepad, but they are more typically produced an consumed by
spreadsheet applications such as Numbers or Excel.
Capture attempts to conﬁgure itself automatically based on the headers Capture uses itself when using the
Export Fixture Data tool, but also based on headers produced by other popular softwares. However,
because ultimately any columns may be present in a CSV ﬁle it may be necessary to manually map some
columns from the CSV ﬁle to Capture ﬁxture properties. This is done in the File column mapping section.
In order for Capture to know whether to update an existing ﬁxture or add a new ﬁxture it is also necessary
to select a property by which to uniquely identify ﬁxtures. This is done with the Identify ﬁxture by dropdown
choice.
When Capture ﬁnds ﬁxtures in the data ﬁle that do not exist in your project it can add new ﬁxtures based on
the information in the ﬁle. How to determine the type of ﬁxture to add is decided by the column selected for
the Fixture property of the New ﬁxtures subsection.
Optionally, Capture can also replace imported objects in your project ﬁle with new ﬁxtures. This behaviour is
enabled by selecting a column for the Drawing name property of the New ﬁxtures subsection. Capture then
uses the Drawing name property of imported objects with the selected column of the data ﬁle to ﬁnd
matches. It is possible to choose whether the match needs to be exact or only partial using the Drawing
name matching property.

Using the Export Fixture Data Tool
The Fixture Data Export tool in the File menu can be used to export CSV data ﬁles as well as grandMA 2 and
Hog 4 XML patch ﬁles of the ﬁxtures in the project and their associated data.
Exported CSV ﬁles can be opened in any text editors such as TextEdit or Notepad as well as spreadsheet
software such as Numbers and Excel. Exported XML ﬁles can also inspected in text editors even though they
are only intended to be imported in the grandMA 2 and Hog 4 consoles.
To export, go to the “File” menu, select “Export Fixture Data..” and specify the desired location and name of
the exported ﬁle. Following this some exporting options are available as well as the ability to change the
exported ﬁle format.

Exporting to grandMA 2
When exporting to grandMA 2, a number of layer schemes are available:
Project layers creates one MA layer for each Capture project layer with exported ﬁxtures.

Fixture types creates an MA layer for each type of ﬁxture exported.
Single creates one MA layer which contains all ﬁxtures exported.
On export a dialog is also shown where it is possible to specify the manufacturer, product name and ﬁxture
numbers of each ﬁxture type exported. If left as is, the ﬁxture types can be assigned in grandMA 2 after
import, but if you wish to to avoid this step (and have already imported all required ﬁxture types in your
grandMA 2 show), then use these ﬁelds to set up the matching information.

Exporting to Hog 4
On export to Hog 4 it is important for the exported ﬁle to contain the exact same manufacturer and product
names as in the Hog 4 ﬁxture library as otherwise ﬁxture will be skipped on import.
On export an additional dialog is shown where you can adjust the manufacturer and product names
exported for each ﬁxture. Crosscheck these with the names of the ﬁxtures available in your ﬁxture library or
use it to change ﬁxture types on export, for instance in order to swap ﬁxtures for desk channels.

Importing exported ﬁxture data in grandMA 2 onPC
First copy the exported MA 2 XML ﬁle to C:\ProgramData\MA Lighting
Technologies\grandma\gma2_V_x.x.x\ﬁxture_layers. Then, on the command line, enter the following
commands, assuming the name of the exported ﬁle was exported_ﬁle.xml:
1. cd EditSetup
2. cd Layers
3. import exported_ﬁle.xml at 1
4. cd /

Motion Controllers
Using DMX Motion Controllers
Capture has the functionality to allow incoming DMX channels to be mapped to control the height and
rotation of objects. In these examples, we are going to look at moving truss around with DMX. The
functionality is not limited to trusses only, it can be used with most objects and forms within Capture.
There are two types of DMX Motion Controllers in Capture. The DMX Mover and the DMX Rotator.
The DMX Motion Controllers are added to a project like any other object in Capture - by dragging them from
the Library into one of the design views. Its best to look at the controllers like lighting ﬁxtures, they are
ﬁxtures in the project. Its good practice to place the movers near to the object they are controlling for ease
of identiﬁcation and manipulation, but they may be hidden from view if required.
The DMX Mover, pictured to the right, has two blobs at each end of the range. The thicker blob indicates the
default starting point of the object the Mover is attached to. The thinner blob indicates the lowest point to
Mover operates to.
The DMX Rotator, pictured to the right, is shown here as it is seen in the “Orthographic Front” design view.
The thick blob in the middle of the circle indicates the central rotation point that the object will rotate
around. The line protruding from the centre of the circle from the blob is the default starting point. The
circle itself indicates the range in which the Rotator can operate. In this case, it is a full circle as the
Rotator has a range of 360 degrees.

Adding a DMX Mover
As we discussed, the ﬁrst type of DMX Motion Controller is the DMX Mover.
The DMX Mover can move an object across a predeﬁned range on the X Y Z axis. The mover can also be
conﬁgured to operate on only one axis, for example Y, so that the object it is attached too will only move up
and down.
Drag the DMX Mover into the project from the library. It can be found under “Motion Controllers”. Position it
near to the truss it will be linked with, this will make it easier to manage projects with multiple movers.
Select the mover and access its properties in the Project Window.
Give the mover a name, using the “Unit” ﬁeld. Then conﬁgure its properties to match the ranges in which
you want to mover to operate. In this case, the X and Z range will be 0 and the Y range will be -5.8m as we
only want the mover to move the truss up and down. 5.8m is the distance between the truss and the ﬂoor.
Select the Truss and the Fixtures you wish to move and select the DMX Mover from the “Motion Fixture”
property in the Project Window.
The DMX Mover can now be selected and manipulated in the Live view just like any other ﬁxture.

Adding a DMX Rotator
The second DMX Motion Controller is the DMX Rotator. The Rotator can be used to rotate an object around
on an axis and within a speciﬁc range on that axis.

Now we add in a DMX Rotator and link the truss to it. We then go on to link the Rotator to the DMX Mover
we created earlier. We call this “Chaining”. Once chained together it means that we can select both the
Mover & Rotator and have individual control over both. The initial placement of the Rotator is of great
importance. Wherever the Rotator is placed will be the point on which the rotation occurs. For example, we
place the Rotator in the middle of the truss so that the truss Rotates around that point. Drag the DMX
Rotator into the project from the library. It can be found under “Motion Controllers”.
Select the Truss and the Fixtures you wish to rotate and select the DMX Rotator from the “Motion Fixture”
property in the Project Window.
Now, select the DMX Rotator and in the “Motion Fixture” property, assign the Rotator to the DMX Mover.
This “Chains” the two motion controllers together so that when we select both, the truss can be moved up
and down and rotated at the same time.
The DMX Mover & Rotator can now be selected and manipulated in the Live view just like any other ﬁxtures.

Patching a DMX Motion Controller
Because a DMX Motion Controller is treated just like a Fixture in Capture, it is patched in the same manner.
You can manually enter its patch and mode data in the properties tab of the Project Window, or you may
use the drag function to drag it onto the start channel of a particular universe. The patch property for the
controller can be found under “Control” in the selected items section of the Design tab.

Snapshots and Video Rendering
Snapshots
The still snapshots makes it possible to quickly move between key lighting looks while making design
changes, even if no console is present. You can create high resolution renders at any point, watermarked
with your logo and project information. Record movie snapshots including DMX, media and motion of parts
of your show for oﬄine playback. Export stand-alone 'Presentation' ﬁles that allow playback of all your
snapshots while in an interactive environment - on any computer! Or if you prefer, render a high quality fullframe rate video ﬁle of your movie snapshots. To record a snapshot, simply press either the Record Still or
Record Movie button in the snapshots tab of the Project Window. When recording a movie look, an extra
dialog box will appear that allows you to set the FPS and start/stop. Snapshots can be played back by
pressing the Play/Stop buttons the appear to the left of the Snapshot in the Snapshot tab.

Advanced File Menu Functions
Special Import Workﬂows
VectorWorks
It is possible to import a design from VectorWorks including both stage design / geometry model and
ﬁxtures. The workﬂow requires access to VectorWorks.
First export a DWG ﬁle from VectorWorks which will contain the stage model as well as the model of the
ﬁxtures. Then also export an “Instrument Data” ﬁle using the “All” setting which will contain all information
about the ﬁxtures in the DWG ﬁle such as their ﬁxture type(s) and patch.
In Capture, ﬁrst use the Model Import tool to import the DWG ﬁle. At this point you will see VectorWork’s 3D
models of the ﬁxtures and be able to select them, but not operate them as Capture does not yet
understand that they are ﬁxtures.
Finally use the Data Import tool to import the “Instrument Data” ﬁle previously exported. Once you have
identiﬁed the ﬁxture types of the ﬁle you will see the previously inanimate ﬁxture models exchange for
regular Capture ﬁxtures, fully functional and with relevant information such as patch and notes transferred
from VectorWorks.

Using the Export Focus Sheets Tool
The export focus sheets feature creates a set of images, one per ﬁxture (or as conﬁgured in the
conﬁguration dialog presented), giving you a view out through the aperture of the ﬁxture. It requires you to
pick a folder into which the images are placed. The feature relies on having assigned “units” within the
project, this can be done by using the “Sequential Unit” feature discussed earlier in the manual. Fixtures that
do not have a unit number assigned will not be exported. You may create focus sheets based on layer
sets, this allows for you to only export certain groups of ﬁxtures. Simply make a layer with only the ﬁxtures
you wish to export, assign it to a ﬁlter, then select that ﬁlter in the export options window. If you only want
to export focus sheets for the selected ﬁxtures, set the “selected ﬁxtures only” option to “Yes” in the export
options.

Update Library
Occasionally, it is necessary to update the Fixture Library in between main software releases. This can be
accomplished by going to the downloads page of the Capture website http://www.capturesweden.com/Dow
nload/Standard.aspx and downloading the latest Library ﬁle.
Note that the library ﬁle has a .c2z ﬁle extension. In Capture, go to the Tools menu. Select “Library Update”
and choose the .c2z ﬁle you downloaded. Capture will install this latest library ﬁle and then prompt you to
restart.

Troubleshooting
Should you run into any problems, do not hesitate to contact us at support@capturesweden.com.

Graphics and Video Driver Related Problems
Capture is a professional visualization software and has high demands on video cards and their drivers. In
case of problems, the following may help:
Updating the video driver
Trying diﬀerent screen conﬁgurations (primary screen, number of screens and maybe even screen
resolutions)
Updating your operating system
Upgrading your graphics card

IP Networking Problems
If your computer is set up with multiple IP addresses, Capture will ask you to select one of them as the
primary. This is important for many protocols and the option required to set is available in the Options
dialog from the Tools menu.

Windows Networking Problems
If your computer is not connected to a network at all but you wish to work with software based controllers
on the same computer it may be necessary to install the Microsoft Loopback adapter. The process is simple
and described at http://support.microsoft.com/kb/839013.

macOS Networking Problems
If you are experiencing problems connecting Capture to your console or oﬄine software under macOS, it
may be worth turning on an oﬀ the macOS ﬁrewall. This is done in the System Preferences, under Security &
Privacy.

